Example screen shots and product functionality are based on the Project 2010 Beta. Actual requirements and product functionality may change with the final release of the commercially available product and also may vary based on your system configuration and operating system.

Information in the document, including URL and other Internet Web site references is subject to change without notice. Except as expressly provided in any written license agreement from Microsoft, the furnishing of this document does not give you a license to any patent, trademarks, copyrights, or other intellectual property that are the subject matter of this document.
# Table of Contents

Microsoft Project 2010 – At a Glance ................................................................. 4
  What’s New ........................................................................................................ 5
  Get a Quick Start .............................................................................................. 5
  Build Dynamic Schedules ............................................................................... 5
  Better Plans, Better Results ............................................................................ 5
  Take Charge of Resources ............................................................................. 6
  Manage Projects and Programs ...................................................................... 6
  Collaborate and Connect ................................................................................ 6

Get a Quick Start .............................................................................................. 7
  Fluent User Interface **NEW!** ....................................................................... 7
  Go Backstage to Share and Collaborate **NEW!** ........................................ 9
  Make It Yours – Personalize the Ribbon **NEW!** ....................................... 9
  Got a List? Get a Plan **NEW!** .................................................................. 11
  Get Guidance from Tooltips **NEW!** ......................................................... 13
  Save Time Using Templates **IMPROVED!** ................................................ 14

Familiar and Essential Functions ................................................................. 14
  Automatic Text Wrapping **NEW!** ............................................................. 14
  Enhanced Auto-Complete **IMPROVED!** .................................................. 15
  Add Columns Quickly **NEW!** .................................................................... 15
  Enhanced Filter, Sort, and Group **IMPROVED!** ........................................ 15
  Enhanced Formatting **NEW!** .................................................................... 17
  Formatting Galleries Save You Time **NEW!** ............................................. 17

Build Dynamic Schedules ............................................................................. 20
  User-Controlled Scheduling Puts You in Control ......................................... 20
    Manually Scheduled Tasks **NEW!** ........................................................... 20
    Automatically Scheduled Tasks .................................................................. 20
    Switch Task Modes **NEW!** ..................................................................... 23
  Simplified Planning with Inactive Tasks **NEW! PRO** ............................... 23
  Task Tab **NEW!** ....................................................................................... 24

Top-Down Planning ....................................................................................... 24
  Define Phases and Outline Requirements **IMPROVED!** ......................... 24
  Compare Top-Down Estimates to Details **NEW!** .................................... 25
  Build Agile Project Plans **IMPROVED!** .................................................. 22

Complete Your Schedule with Ease and Precision ..................................... 26
  Intuitive Guidance with Task Inspector **NEW!** ..................................... 26
  Visual Indicators **NEW!** ............................................................................ 26
# Table of Contents

## Better Plans, Better Results
- Timeline View **NEW!** ................................................................. 27
- Communicate Your Plan **NEW!** .................................................. 29
- Share Project Files in PDF and XPS Formats **NEW!** .................. 29

## Take Charge of Resources
- At-A-Glance Resource Management with Team Planner **NEW!** 30
- Resource Tab **NEW!** .................................................................. 32
- Flexible Choices for Resource Planning ....................................... 32
- Simplified Resource Workload Analysis ....................................... 32
  - Visual Cues Highlight Overloaded Resources.......................... 33
  - Identify Workloads and Trends with Visual Reports **IMPROVED!** 33
- Enhanced Resource Leveling Helps Smooth Resource Workloads **IMPROVED!** 33

## Manage Projects and Programs
- Monitor and Control Project Progress ....................................... 34
  - SharePoint Integration for Team Member Updates **NEW!** **PRO** 34
  - Quickly Update Project Status .................................................. 34
  - Choose a Status Reporting Date ............................................... 34
- Perform What-If Analyses **IMPROVED!** .................................. 35
- Create Compelling Reports for Insight and Analysis **IMPROVED!** 37
- Project Performance and Earned Value Management ................. 37
  - Compare Actual Values to Baseline Estimates ......................... 37
  - Create Earned Value Reports .................................................. 37
- Get a Handle on Project Finances .............................................. 38
  - Establish Budgets .................................................................... 38
  - Fill in Detailed Costs and Compare to Budget ......................... 38
- Effectively Monitor Programs with Master Projects ................. 38
  - 64-Bit Options **NEW!** .......................................................... 38

## Collaborate and Connect
- Connected Teams – SharePoint Synchronization **NEW!** **PRO** 39
- Create Projects from SharePoint Lists **NEW!** **PRO** ................. 42
- Save Project Schedules to SharePoint **IMPROVED!** .................... 42
- Connect to Project Server 2010 **IMPROVED!** **PRO** ................. 42

## Summary of Project 2010 Benefits ........................................... 43

## System Requirements and Compatibility ............................... 45

## Versions and Compatibility....................................................... 46
- Version and Edition Comparison ................................................ 46
- Compatibility with Earlier Versions ......................................... 46

## Additional Resources ............................................................... 47
Microsoft® Project 2010 – At a Glance

Microsoft® Project 2010 delivers powerful, visually enhanced ways to effectively manage a wide range of projects and programs. From meeting crucial deadlines, to selecting the right resources and empowering your teams, Project 2010 offers easier and more intuitive experiences to simply be productive and realize amazing results.

Project 2010 is a significant release that delivers innovative features across the entire family of products: Project Standard 2010 and Project Professional 2010 for occasional and professional project managers, and Project Professional 2010, combined with Microsoft® Project Server 2010, for the power and depth to meet the needs of larger organizations. Project 2010, built on SharePoint 2010, offers flexibility and choice by providing tailored work management solutions for individuals, teams, and the enterprise.

With Project Standard 2010, you have a new and easier way to manage simple tasks and projects. With significant updates and visual enhancements, Project Standard 2010 delivers a better experience for you to simply be more productive and to successfully complete any type of project. Building on the new features and visual enhancements in Project Standard 2010, Project Professional 2010 meets your project management needs with at-a-glance resource management and team collaboration tools using Microsoft SharePoint® Foundation 2010 (formerly Windows® SharePoint Services). In addition, you and your organization can realize the power of unified project and portfolio management by combining Project Professional 2010 with Project Server 2010. Together, Project Professional 2010 and Project Server 2010 create the Microsoft Enterprise Project Management (EPM) Solution, and give you the tools to prioritize investments and optimize resources, gain control of all types of work, and visualize performance using powerful dashboards.
What’s New

Get a Quick Start

▪ Get started quickly with the intuitive Microsoft® Fluent™ user interface. Project 2010 offers the Microsoft Fluent user interface, which incorporates the Ribbon, a new design on the Microsoft Office Ribbon introduced in the Microsoft Office 2007 system. Using the simpler graphical menus and familiar experience of the Ribbon, your favorite tools are always at your fingertips, to help you create and manage projects more easily.

▪ Work smarter and faster with the Microsoft Office Backstage view. In the new Project 2010 Microsoft Office Backstage view, you can save, print, share, and publish your projects with fewer clicks to save time and effort.

▪ Integration with Microsoft Office applications. Integration with other Office applications is simple and hassle-free so you can manage your project with less effort for better results. Get your project plan started by copying outlines and brainstorming notes from Office applications like Microsoft Word and Microsoft Excel®. Enhanced copy-and-paste capabilities preserve formatting from the source file, including fonts, colors, and text. Efficiently share and communicate your project plan with other Office applications using the same copy-and-paste functions.

▪ Familiar, essential functions. Like other Office applications, in Project 2010 you will save time and effort by using familiar and essential functions like text wrapping, auto-complete, scroll, zoom, and enhanced filtering. You can easily insert new columns for entering data; data types are readily identified so you can quickly and effectively organize and analyze details. New tooltips, context-sensitive help, and a larger selection of templates quickly get you started and working effectively.

▪ Expanded template selection. Select from a wide range of new project templates of all types, from all industries, to get started quickly. In addition, you can share with team members the templates that you have created or customized to help promote consistency and best practices.

Build Dynamic Schedules

▪ User-controlled scheduling puts you in control. Bringing together the flexibility and ease of a tool like Excel 2010 with the power of the Project 2010 scheduling engine, user-controlled scheduling offers flexible choices for developing and managing projects. Manually scheduled tasks let you set values in Start, Finish, and Duration fields, leave them blank, or insert notes for future reference.

▪ The new Task Inspector offers intuitive analysis and guidance. Gain insight on resource conflicts and scheduling issues using the Task Inspector tool, so you can identify and take action to resolve issues.

▪ Simplify planning with Inactive tasks. Using Project Professional 2010, inactive tasks lets you easily experiment with your project plan and perform what-if analysis. A simple toggle inserts or removes one or more tasks and their effect on the project schedule.

Better Plans, Better Results

▪ New Timeline and visual cues. With a completely new Timeline view, you will have a clearer view of tasks, milestones, and phases associated with your project. Newly expanded color palettes and text effects help you make every timeline and plan look its best, so you can swiftly see and share important dates and deliverables. Visual indicators alert you to potential issues.

▪ Create summary-level plans in Manually Scheduled task mode. Early in a project you can use limited details to enter high-level summary
tasks in the Manually Scheduled task mode. You can add task, resource, and date details later, when they become available, and then visually compare the result of a schedule constructed of cumulative details against top-level summary plans.

▪ **New font and graphics formatting controls.** Use color and font formatting controls with the Timeline view to highlight and communicate key aspects of your project.

▪ **Share your timeline easily.** Enhanced copy-and-paste functionality means swiftly arranging and rearranging your timeline, while retaining fidelity of colors, fonts, and graphics.

▪ **Save projects in PDF and XPS format.** You can easily save a file in PDF or XPS format, so you can share with others and to save snapshots of the evolution of your project for reference.

**Manage Projects and Programs**

▪ **Easy updates.** Update task assignments and schedules more easily using Ribbon commands and Team Planner functions.

▪ **SharePoint-based status updates.** Enhance team collaboration to realize results—connect your teams with Microsoft SharePoint Foundation 2010 synchronization.

▪ **Compare Projects tool.** Perform what-if analyses using the enhanced capabilities of the Project 2010 Compare Projects feature.

**Collaborate and Connect**

▪ **Utilize bi-directional task status updates with SharePoint Foundation 2010 for team synchronization and collaboration.** Project Professional 2010 connects your teams with SharePoint Foundation 2010 synchronization to help you work better together.

▪ **Turn SharePoint lists into projects.** Using Project Professional 2010 it’s easy to use a SharePoint Foundation 2010 task list as the basis for a new project plan. An easy-to-use wizard maps the fields in your SharePoint task list to Project fields—this means reduced data entry and no redundant formatting for you.

▪ **Share your project using SharePoint.** Team members can save project files directly to a SharePoint Foundation 2010 site for enhanced collaboration on and control of their projects.

▪ **Team up with Project Server 2010 for an end-to-end project and portfolio management solution.** In addition, you can choose to combine Project Professional 2010 with Project Server 2010 to realize the results of unified project and portfolio management.

**Take Charge of Resources**

▪ **New Team Planner in Project Professional 2010—an interactive tool for visualizing team assignments.** The new interactive Team Planner tool in Project Professional 2010 combines at-a-glance resource management with drag-and-drop simplicity for moving tasks between resources. Inactive task’s capabilities promote enhanced scheduling and what-if scenarios. Use drag-and-drop actions to easily move assignments between team members. Visual cues in Team Planner resource views call out resource overload conditions.

▪ **Enhanced resource leveling.** Take advantage of enhanced leveling capabilities to pinpoint and selectively resolve resource issues.

▪ **Improved Visual Reports feature.** Using improved Visual Reports you can create stunning project summary charts and more intuitive, detailed data analyses.
Get a Quick Start

Project 2010 offers an intuitive and familiar interface so you can get set up and get going. Project 2010 is designed to work more like other Office 2010 applications, which means efficiency and simplified project management for you. Set up your workspace the way you like it—Project 2010 offers the flexibility and choice that supports the way you like to work.

Fluent user interface
Using Project 2010, you can locate the commands you need when and where you want them. Through detailed and extensive user research, Microsoft has discovered which commands people use most, the sequence in which people commonly use commands, and which commands users typically access through the toolbar, mouse, or keyboard. Based on that research, we made commands easier to find in Project 2010 (and across all Office 2010 applications). This gives you a better experience and helps you get more done in less time.

The Fluent™ user interface, new in Project 2010, makes finding and using your favorite tools simpler by incorporating new graphical menus and a familiar experience so you can create and manage your projects more easily.

With solution-oriented tabs for managing projects, resources, and tasks, commands and features that were previously configured in more complex menus have been brought to the surface for easy use. In Project 2010, contextual tabs provide formatting options and show available actions based on the view or item selected. Context-sensitive actions are grouped so you can easily find and choose the right command. Relevant actions are presented so you can complete your work quickly without navigating through multiple menus.

QuickTip
Easier Access to Features with the Ribbon
With the Ribbon incorporated into Project 2010, you will find it much more intuitive to access relevant features and functions based on how you plan, track, and report on projects. All the old menus and toolbars have been replaced with the new Ribbon that organizes commands into logical groups on each main tab, so you can be more efficient.

Continued on next page
Step by Step - Easier Access to Features and Functions

1 Plan and manage tasks using the Task tab. On the Task tab you will find it easier to access relevant commands for planning and managing tasks. For example, in the Insert group you can easily insert phases (for summaries) and milestones. Or, in the Schedule group you can switch from manual to automatic scheduling; to easily move tasks, click the Move Task button.

2 Plan and manage resources using the Resource tab. On the Resource tab you can find and use relevant commands for planning and managing resources. In the Insert group you can add resources to your resource pool, or in the Assignments group, click the Assign Resources button to quickly and easily assign resources to tasks.

3 Plan and manage project-level information using the Project tab. On the Project tab you can plan project-level information. For example, in the Properties group, click Project Information to define the Project Start date, or click Change Working Time to modify your working calendar in the Change Working Time dialog box.
Go Backstage to Share and Collaborate

Click the File tab on the Ribbon to open the new Microsoft Office Backstage view, new in Project 2010, for quick access to tools, templates, and application options.

The Backstage view helps you work with your project file. Here you will find a rich, full-screen environment for working with your project so you can quickly save, print, and share your file, in addition to accessing document properties and options. Sharing options include creating a PDF or XPS document from your project plan or saving your project plan to a SharePoint Foundation 2010 site for team collaboration. Easy-access tabs help you quickly find recently used files and change document properties. The Backstage view is also where you set application options and personalize the Ribbon toolbar and command menus.

What’s new. The Backstage™ view

The Backstage view provides a rich full-screen environment for working with your project so you can quickly save, print, and share, as well as access document properties and change options.

- **File Tab**: Click on the File Tab (or any of the Ribbon Tabs) to return to the project view for editing.
- **Info Tab**: Display information about your project and change document properties.
- **Recent Tab**: Display a list of recently saved projects. You can “pin” projects to the list by clicking on the pushpin icon next to the project file name.
- **New Tab**: The New Tab presents a rich set of options and templates for starting new projects.
- **Print Tab**: Click the Print Tab and access one easy-to-use view that combines the print preview and print dialogue boxes from previous editions. Click on the large “Print” button when you are ready to print.
- **Save & Send Tab**: The Save & Send Tab gives you a set of options for sending and sharing your work.
- **Help Tab**: The Help Tab is where you will find application options and resources to help you get the most out of Project 2010.

Figure 2 - Getting started with the Office Backstage view

Make It Yours – Personalize the Ribbon

Make it your workspace! With Project 2010, you can personalize the Ribbon for the way you want to work. This includes creating custom Ribbon tabs with specific commands organized for common actions or for your preferences. You can also place your most commonly used or easily forgotten commands on a Quick Access toolbar so they are always available.
QuickTip

The Ribbon and Quick Access Toolbar – Easy to Customize

In Project 2010 it’s easier than ever to personalize your experience. For single-pass access to customizing the Ribbon, on the Project 2010 Ribbon, click the **File** tab, and then click **Options**.

In addition, the status bar at the bottom of the Project 2010 screen shows key program settings, and provides shortcuts to useful functions. Using View and Zoom controls on the status bar you can quickly change your project view and timescale.

**What’s new: The Ribbon**

The Ribbon makes finding and using your favorite tools simpler and more intuitive.

- **File Tab**: Click on the File Tab to open the Backstage™ view. Here you’ll find many commands (such as Print, Save and Sorts for working with your projects and setting application options – including customizing the Ribbon).
- **Quick Access Toolbar**: Add the tools you use most to the Quick Access Toolbar and activate them with one click no matter which tab is displayed. Right-click a Ribbon tab to add it to the Quick Access Toolbar.
- **Contextual Tabs**: Contextual tabs appear automatically when you select objects like drawings, tables, and charts with specific editing or formatting commands.
- **Manually Schedule**: Click here to adjust a selected task manually so that the values you enter for Start, Finish, and Durations are not automatically updated.
- **Status Bar**: From the Status Bar you can determine whether your view is filtered, set how row tasks are created, and view your connection status.
- **Zoom and View**: Click here to easily change views or zoom in and out.

Figure 3 - Getting started with the Ribbon
Got a List? Get a Plan

Project plans often get started as outlines or notes created in Office applications such as Word, Excel, or Microsoft Outlook. Project 2010 incorporates enhanced copy-and-paste capabilities that retain the formatting and hierarchy of task lists started in other Office applications. In addition, Project 2010 offers powerful ways to share your project timeline and schedule details with people who don’t currently use Project 2010, and to collaborate online.

In earlier versions of Project, you could copy lists from other Office applications into Project but would need to format and indent items in Project to match their original outline design. Project 2010 retains your project outline structure in indented lists copied from other Office applications and automatically creates summary tasks in your schedule based on list hierarchy. Project 2010 also retains text formatting from your Office file, including fonts, text effects, date formats, and colors. For example, if you initially use Excel to outline your plan and put task fields in the same column order as you want them to appear in Project, you can quickly create your Project schedule with all of the relevant task information—dates, numbers, and formatted text—intact and ready to use.

In addition, using Project 2010, you can share project details by copying from Project 2010 to other Office applications. Copied sections of your project plan retain full fidelity when pasted into other Office applications, such as Excel, Word, and Outlook; all visual and data formats in your project schedule are retained. For example, pasting Project 2010 schedule details into Excel or Word retains column headings along with the schedule task list. Pasting Gantt schedules into other Office documents retains the schedule outline, data formats, and colors that you’ve incorporated into your schedule in Project 2010.

QuickTip

Rich Copy-and-Paste Support

The copy-and-paste function is still alive and well. In fact, it is even better than ever with Project 2010 because you can now copy and paste content and retain key formatting such as outline levels and column headings. It could be as simple as copying a task list from an e-mail, or moving a complete plan from Project to Excel. Either way, with improved copy-and-paste capabilities in Project 2010, you will be more effective setting up project plans and communicating relevant project information.
Get a Quick Start

Continued from previous page

Step by Step - Share Information Between Office Applications

1 **Copy data from another source.** To copy data from another source, such as an e-mail message, an Outlook task, or from another Office application, drag the pointer to select the text you want to copy, right-click, and then click **Copy.**

Drag the pointer to select the text you want to copy, right-click, and then click **Copy.**

2 **Paste into Project 2010.** In Project 2010, click the column (or columns) that you want to paste the data into. In the following example, you are pasting tasks into the **Task Name** column. Right-click, and then click **Paste.**

Note that the outline structure has been retained after pasting the copied data, and that **Design,** **Develop,** and **Implement** are all phases (summary tasks) in the Project 2010 schedule.

3 **Copy and paste from Project to another Office application.** To copy and paste data from Project 2010 to another Office application, in Project 2010, click the column headings and data that you want to paste into an Office application, such as Excel, Word, or Microsoft PowerPoint®. After copying and pasting the content, the formatting and column headings will be retained in the new application for more effective presentation and communication.

We think you will be impressed how easy it is to share project information without retyping or reformatting text!
Get a Quick Start

Get Guidance from Tooltips

Descriptive tooltips are displayed to provide context-sensitive help when you place your mouse over action buttons on the Ribbon. You can also preview results before committing changes, or quickly view additional options for a specific action.

In addition, Project Help is available, as always. Click the Help button in the Backstage view to find application options and resources to help you get the most out of Project 2010.
Get a Quick Start

Save Time Using Templates

You can quickly build your plan and streamline your project management process by choosing a predefined template, included in the Project 2010 installation. Templates give you a quick start by pre-populating a new project with organized tasks and role-based assignments. Templates are readily available in the Backstage view and are designed to enhance your productivity.

You can also download templates, organized by common activities, such as an office move, product launch, or systems development effort, from Microsoft online resources. Or, you can save previously created project plans as templates to reduce effort and promote best practices on future projects. When using Project Professional 2010 with Project Server 2010, your templates are available across the enterprise to promote consistency and to share best practices.

Familiar and Essential Functions

With Project 2010 you can simply be more productive. Like other Microsoft Office applications, familiar and essential functions like text wrapping, improved filtering, auto-complete, scroll, and zoom save you time and effort in Project 2010.

Automatic Text Wrapping

In Project 2010, text automatically wraps when you enter details—such as tasks, resource names, and notes—into data fields. In addition, in Project 2010, you can automatically adjust row height and column width to clearly see project information.
Enhanced Auto-Complete  **[IMPROVED!]**
Auto-complete have been dramatically improved in Project 2010 so that it displays a filtered list of previously used values or choices from a drop-down list as you begin typing in a field. Avoid scrolling through long lists of values just by typing the first letters of a valid choice, and then immediately select from an auto-complete list of options.

Add Columns Quickly  **NEW!**
Project 2010 offers an easier way to add columns. On the **Format** tab, simply click **Insert Column**; data types are preformatted and easy to identify, including dates and currency, so you can quickly and effectively organize and analyze details. You can later easily change the name of a column, field, or data type as needed for project and reporting requirements.

---

**QuickTip**

**Add New Columns with a Click**
The Add New Column feature helps you manage and communicate your project information. The default Gantt chart view comes with standard columns such as **Task Name, Duration, Start, Finish, Predecessors**, and **Resources**, but there will be plenty of times when you might want to add other columns, such as Work or Costs, and even save your creation as a new table for future use.

---

**Step by Step - Quickly Customize the Information You Work with Using the Add New Column Feature**

1. **Add new columns to the existing table in the Gantt chart.** In the Gantt chart view, scroll right until the **Add New Column** heading appears. Click **Add New Column**, and then scroll down the list to find the field you want to add, or type in the first few letters of the field, such as **wo** for **Work**, to create a short list of relevant words, and then click the column field you want to add.

---

**Continued on next page**
**Get a Quick Start**

**Continued from previous page**

2. **Move the new column.** You can easily move the new column anywhere in the table by clicking and dragging the column heading to the left or right. In this case, click the **Work** column and move it next to the **Duration** column.

3. **Save the newly formatted table as a custom table.** With the table customized and your new column added, you can save your settings as a custom table with a new name for future use. On the **View** tab, in the **Data** group, click **Tables**. In the drop-down list, click **Save Fields as a New Table**. In the **Save Table** dialog box, type a name for your table—for example, **My Planning Table**. The table will now appear under **Custom** on the **Tables** drop-down list.

Enhanced Filter, Sort, and Group  

In Project 2010, filtering, grouping, and sorting options are applied to views using an intuitive Office dialog box.

Project 2010 filter choices let you focus on a set of project tasks or resources that you select. AutoFilter displays check boxes and common time frames—for example, **Next Week**—offering you easy control over the information presented in views.

In addition, you can apply column sorting and group-by functions using the same intuitive dialog box.
Enhanced Formatting  
It’s now easier to see and share information in Project 2010. Newly expanded color palettes and text effects help you swiftly see and share important dates and deliverables. Using a fully expanded Office color palette, you can personalize the look of your project plan, including Gantt chart bars, field text, and backgrounds to maximize visual effect and convey information.

Format Galleries to Save You Time  
Using the drop-down galleries in Project 2010 you can clearly see the available options for items in your current view. Formatting galleries save you time by displaying preformatted visual effects to apply to text and graphics. In addition, you can preview the results before making a selection. For example, a gallery of Gantt chart formatting options lets you quickly select from a wide array of bar colors and styles.

Figure 7 - AutoFilter
QuickTip

Format the Gantt Chart

With the Fluent™ user interface incorporated into Project 2010, you will find that accessing more relevant features and functions based on how you plan, track, and report on projects is much more intuitive. All of the menus and toolbars in earlier versions of Project have been replaced with the new Ribbon that organizes commands into logical groups on each main tab, so you can be more efficient in getting things done. Whether you are managing your tasks, resources, or project information, or if you simply need to communicate more effectively, the Ribbon serves up relevant commands in a manner that matches the way you work. Following is just one example of how easy it is to format a Gantt chart, for instance, to better convey the details of your project.

Step by Step - Present Information More Effectively Using the Format Tab

1 Format views. On the Format tab you can easily format views for more effective communication. For example, you can modify the Gantt Chart Style or create Custom Fields in the Columns group.

2 Set styles using a formatting gallery. In the Gantt Chart Style group, click a bar style. Use the right scroll bar to see additional options.

...Continued on next page...
3 Set other style options. In the Bar Styles group you can set other style options, such as for Critical Tasks or Baseline. To format Critical Tasks, in the Bar Styles group, select the check box next to Critical Tasks. To format Baseline, click Baseline (Baseline format options will appear only if you have baselines set).
Build Dynamic Schedules

Project 2010 offers a fresh and intuitive approach to planning and building project schedules. You can choose the level of detail that’s right for each of your projects—work with summary data initially or change to a more detailed view. Place notes as reminders of where additional schedule information is needed, or simply add information later when it becomes available. You have the flexibility to build your schedule with the precision and power you need to communicate your project vision and timeline.

User-Controlled Scheduling Puts You in Control

User-controlled scheduling is a powerful new feature in Project 2010. User-controlled scheduling helps project managers at all levels quickly and easily create their project plan. You choose the level of detail that’s right for your project to effectively communicate actions and outcomes.

Manually Scheduled Tasks

User-controlled scheduling puts you in control and brings together the flexibility and ease of a tool like Excel 2010 with the power of the Project 2010 scheduling engine. Using Manually Scheduled task mode you can start planning with the information you have now, and fill in details later. This is particularly useful early in the planning process, when details are still unclear or nonexistent—Start, Finish, and Duration fields can be left blank, hold text values, or include specific dates or durations.

For example, if you know when you would like to get started on a task but do not know how long it will take to complete the task, you can enter only the task start date. Project 2010 will show a unique bracket icon on the Gantt chart timeline on this date. If you have an estimate for how long a task will take but do not have a commitment date to start, you can add only the duration. Project 2010 will show a transparent Gantt bar to depict the duration of the task. You can also add notes in Start, Finish, and Duration fields—for example, Need estimate from John—to help you identify further actions or information needed.

Tasks scheduled using Manually Scheduled task mode will hold their dates. You can create logical dependencies in manually scheduled tasks but not allow linked tasks to affect these assigned dates or times. For example, you might precede a manually scheduled task for a training class scheduled on a specific date with a training class preparation task. The start of the training class task will stay as scheduled even if the class preparation task is delayed.

Figure 8 - Manually scheduled tasks retain your dates
Easier Planning with User-Controlled Scheduling

Planning your project has never been easier. User-controlled scheduling puts you in control and brings together the flexibility and ease of a tool like Excel 2010 with the power of Project 2010. Choose the level of detail that's right for each project. Work with summary data initially or start with the details for more complex phases or projects. This is particularly useful early in planning when details are still unclear.

Step by Step - Easier Planning with User-Controlled Scheduling

1. **Set duration.** For duration estimates, enter information directly into the Duration column. For example, type **Approx. 1 month** or **2 weeks assuming no customization**, or enter more traditional estimates such as **1 day**, **1 week**, or **1 month**.

2. **Set start and finish dates.** Enter start and finish dates directly in the Start and Finish columns. For example, type **1 week after delivery**, **1 month before installation**, or **Order material 10 days before ground breaking**.

3. **Enter high-level phase or summary estimates.** You also have the option of entering estimates at the summary task or phase level without being affected by roll-up calculations of related (indented) detail tasks below the summary or phase level. This makes it easy to perform high-level estimating and top-down scheduling.
Build Dynamic Schedules

Project will by default create tasks in Manually Scheduled task mode when lists are copied from another application. Project 2010 retains any copied dates, and users can immediately start modifying the schedule in Manually Scheduled task mode or change to Automatically Scheduled task mode to engage the Project 2010 scheduling engine.

Automatically Scheduled Tasks

Project 2010 offers a highly structured and systematic approach to managing project schedules. You can choose to leverage the powerful automatic scheduling engine in Project 2010 to create an optimal forecast for your schedule.

Project uses the Critical Path Method (CPM) to calculate the earliest and latest dates for tasks and helps you predict completion dates for milestones and projects. Automatically scheduled tasks incorporate numerous factors, such as task duration, planned work, number of resources, dependencies between tasks, and calendars to derive dates and resource workloads.

In Project 2010, tasks created in Automatically Scheduled task mode are identified by a unique double bar icon in the Task Mode column. Tasks created in Manually Scheduled task mode are identified by a blue push-pin icon.

![Figure 9 - Unique icons reflect the task mode](image)
**Switch Task Modes**

In Project 2010 it's easy to switch task modes. You can simply and easily switch between Manually Scheduled and Automatically Scheduled mode for one or more selected tasks. When entering new tasks, the status bar shows the default task mode in use.

![Figure 10 - Easily change from Manually Scheduled to Automatically Scheduled task mode](image)

**Simplified Planning with Inactive Tasks**

With Project Professional 2010, you can toggle between Active and Inactive task mode for specific tasks. For tasks designated Inactive, task names and related information will be presented in light gray strikethrough font, and will not be factored into the schedule. Inactive task mode offers a convenient way to temporarily or permanently remove tasks from project plans without affecting the integrity of the entire project schedule. When toggled to Inactive mode, tasks retain previously recorded schedule and resource data, but this information is excluded from Project 2010 schedule calculations. If you are connected to Project Server 2010, task assignments will automatically be removed from resources when tasks are made Inactive.

![Figure 11 - Inactive tasks simply planning and what-if analysis](image)
Build Dynamic Schedules

Task Tab  NEW!
The new Project 2010 action-oriented Fluent™ user interface gives you the tools to build and adjust your tasks quickly and easily. You can easily perform concurrent actions by highlighting multiple tasks and then selecting commands on the Task tab on the Ribbon. This includes creating and removing indents, creating or removing links between tasks, setting progress status, and setting formatting options like fonts, text effects, and cell background colors.

In Project 2010 it takes one click to insert summary or milestone tasks directly into your schedule on the Task tab. In addition, you can easily toggle between Manually Scheduled and Automatically Scheduled task mode directly on the Ribbon, and reschedule tasks by a fixed period of time—for example, two weeks forward—or change to a specific date.

Top-Down Planning
Top-down planning combined with user-controlled scheduling makes high-level estimating and scheduling simple in Project 2010.

Define Phases and Outline Requirements  IMPROVED!
In earlier releases, Project automatically derived start and finish dates of projects, in addition to any summary-level phases, from the earliest start and latest finish dates based on underlying tasks. Users first had to determine, enter, and manage task details and dependencies, beginning with the smallest components, to create a high-level plan with anticipated project and phase dates. With the new user-controlled scheduling, working in Manually Scheduled task mode you can quickly outline your project and create a high-level forecast based on your high-level project dates and timeline estimates.

You can add supporting activities as subtasks to top-level summary tasks. You can use both Manually Scheduled and Automatically Scheduled task mode to define detailed work activities and deliverables, to build and fill in your schedule. As you and your team define the effort estimates, resources, expenses, and dependencies needed for the work, you can formalize your decisions and update tasks accordingly.

Figure 12 - Begin with the data on hand

You can type in words or leave fields blank. User-controlled scheduling puts you in the driver seat for dates and duration.
Build Dynamic Schedules

Compare Top-Down Estimates to Details  

Project 2010 offers Gantt chart tools to help you review and identify differences between top-down estimates and bottom-up plans. Project 2010 shows the top-level Gantt chart bars with any start and finish dates entered for top-level summary tasks created using Manually Scheduled task mode. Underlying detail tasks are summarized as a single roll-up summary bar, with the earliest start and latest finish dates entered for all subtasks. This roll-up summary Gantt chart is displayed separately from the top-down summary bar to provide a visual comparison of top-down summary to details.

![Gantt Chart Example]

Figure 13 - Easily spot and resolve task mode scheduling conflicts in the Gantt Chart view

In Project 2010 you have a choice to apply top-down scheduling or revert to automatic bottom-up scheduling, based on your project plan details, at any time. You can easily compare detail-calculated roll-ups with original summary estimates and decide which one to use. For example, if your underlying tasks extend beyond the end date of your top-level summary task, Project will extend the roll-up Gantt bar and it will appear in red font. The original dates in your phase top-level summary task Gantt bar are not changed, but you can see and resolve differences.

Build Agile Project Plans  

The Project 2010 top-down approach to planning supports agile methodologies. Project managers who employ agile methodologies can easily plan and estimate feature group schedules and compare team estimates with overall iteration estimate timelines. In addition, agile project managers can toggle specific tasks or task groups between Active and Inactive task mode in Project Professional 2010 to easily manage feature sets in iterations against fixed timelines.
Build Dynamic Schedules

Complete Your Schedule with Ease and Precision

Project 2010 makes it easy to build your project schedule and to quickly identify changes in the schedule over time. Visual indicators help call out issues and conflicts. The new Fluent user interface puts frequently used tasks and features at your fingertips, and offers convenient tools like Task Mode, from which you can simply toggle between Automatically Scheduled and Manually Scheduled tasks. The new Task Inspector tool provides intuitive analysis and guidance, and in Project Professional 2010, Inactive tasks help you temporarily remove tasks from your schedule without deleting them.

Intuitive Guidance with Task Inspector

The new Task Inspector tool in Project 2010 provides context-driven guidance for analyzing issues and taking corrective action. Task Inspector is a multifaceted pane that offers helpful and intuitive information about a task, such as resources assigned, factors that might affect the task schedule, and the calendars in use. You can use Task Inspector in conjunction with Project 2010 visual indicators to research potential problems.

Task Inspector offers options for resolving scheduling conflicts derived from a task's attributes and assigned resources. Task Inspector displays the optimal solution, taking into account task characteristics (for example, fixed duration), task drivers, and resource calendars. For example, click the Respect the Link option for a task and Project 2010 will observe predecessor tasks and use automatic scheduling to resolve the issue. You can choose which Task Inspector option to use and then see the results in your schedule. You can also choose to ignore generated advice; Task Inspector will not display additional guidance.

Visual Indicators

Project 2010 offers expanded, intuitive visual tools to alert you to conditions that require your attention, such as missed deadlines or over-allocated resources. In addition, Project 2010 provides visual cues in key project fields, such as task and project start or finish dates, to highlight potential scheduling or resource conflicts.

For example, text underlined in red in a Start or Finish date field indicates a scheduling issue. Alternatively, text underlined in green identifies a buffer or slack that you can use somewhere else in your project schedule. You can right-click a cell within one of these indicators to display a pop-up menu with solution-focused options for resolving the issue.
Better Plans, Better Results

With a completely new and visually enhanced Timeline view, Project 2010 provides an easier, more intuitive way to see and share key dates and deadlines.

Timeline View

Using the new Timeline view in Project 2010 you can quickly build a compelling high-level graphical overview of your project schedule. You can easily add one or more tasks to the timeline, including summary tasks, milestones, and even partially completed tasks created in the Manually Scheduled task mode. Newly expanded color palettes and text effects help you make each timeline and plan look its best, and efficiently convey important dates and deliverables.

The Timeline view can be displayed as a single graphical bar or as a detailed stack-bar timeline. You can display a view that shows key dates or milestones, phases or tasks for any part of your project. In addition, you can illustrate key milestones or phases using the visual effects and colors that you enjoy in other Office applications to illustrate and communicate your plan.

Using pan and zoom options you can examine your schedule in different time views—for example, by quarter, month, or week. Panning the timeline right or left also moves the time interval in the underlying Project Gantt chart. Double-click any item in the timeline to look at details. Place your mouse over any task to see Percent Complete, Duration, Start, and Finish values. You can even compare different versions of a project in the Timeline view. Changes between the two files are highlighted here so you can easily identify essential differences.
QuickTip

Communicate More Effectively with Timeline View

One of the best new features in Project 2010 is the Timeline view. The Timeline provides you with a high-level, “big picture” overview of the entire project. You can easily add key milestones or other key tasks to create a concise project summary for more effective communication to key stakeholders. When you are ready, you can send it off in an e-mail, add it to a presentation, or simply print it for an eye-catching executive-style report.

Step by Step - Communicate More Effectively: Effortlessly Add Key Milestones to the Timeline View

1. **Add milestones to the Timeline view.**
   The default view in Project 2010 is a combination of the Gantt chart view with the Timeline view layered above it. In the Gantt chart, click the task or milestone you want to add to the Timeline view. Right-click the milestone, and then click **Add to Timeline.**

2. **Format the milestones.** After adding milestones to the Timeline view, you can format them with the colors you want to use. Click the milestone in the Timeline view to automatically activate the Format dialog box. You can quickly and easily format your milestone font and background color.
Communicate Your Plan  

Share your Timeline in e-mail messages, documents, and presentations. The Copy Timeline feature in Project 2010 is a special function with several image choices when you want to paste the Timeline into other Office applications. The Timeline image created is an editable Office Art shape that can be formatted using graphics options, such as 3-D effects, in the Office application of your choice. You can also alter the text and display format for fonts, colors, and styles for enhanced visual appeal.

Share Project Files in PDF and XPS Formats  

Sometimes you need to share your project schedule with people who might not be able to view a Project 2010 file or who need a snapshot of your project at a specific point in time. With Project 2010 you can share your project file in the widely viewable PDF and XPS formats. You can e-mail the resulting file or save it to a shared location for review or for historical reference.
Take Charge of Resources

Choose Project 2010 when you need enhanced resource planning, task control, and collaboration capabilities. Using Project 2010, individuals, teams, and organizations have the tools they need to more effectively plan and manage resources for successful projects. The new Team Planner tool in Project Professional 2010 provides an at-a-glance interactive view for resolving complex resource scenarios. A variety of resource types are available to support a wide variety of planning scenarios. In addition, Project 2010 offers contextual guidance to help you effectively manage resource demands and resolve resource allocation challenges.

At-A-Glance Resource Management with Team Planner  

With Project 2010, you can visually select the right mix of resources—it’s as easy as a drag-and-drop action using the new Team Planner view. In Team Planner, you can see your team’s work, by individual or by role, over the course of your project. You can easily spot problems and resolve issues with drag-and-drop simplicity.

Team Planner offers a graphical and interactive resource-centric view of assignments on a timeline. Multiple tasks are layered in the view so you can see when assignments overlap between team members.

Pause your mouse over actions on the task bar to display task-level information and warning messages.

In addition, you can easily zoom in on specific time intervals to search for gaps in resource work efforts or over-allocation scenarios.

The Team Planner view offers an intuitive analysis of your project tasks by splitting the view into four purposeful quadrants. Each quadrant reflects a unique combination of assigned and unassigned, and scheduled and unscheduled tasks. You can quickly identify tasks that do not yet have resources assigned, in addition to tasks that have not yet been scheduled.

Figure 19 - Assigned tasks in Team Planner
Take Charge of Resources

QuickTip

Dynamic Scheduling with Team Planner

In the Team Planner view, you can see at-a-glance the tasks assigned to resources. With a simple drag-and-drop motion, you can change existing assignments for over-allocated resources or assign unassigned tasks to available resources. In the Team Planner view you will find that managing resources just got a whole lot easier.

Step by Step - Effectively Manage Resources with Team Planner

1. **Go to the Team Planner view.** To open Team Planner, on the **View** tab, in the **Resource Views** group, click **Team Planner**. (You can also access Team Planner at the bottom of the Project screen, in the **View** shortcuts on the status bar.)

2. **Drag and drop unassigned tasks to available resources.** In the Unassigned Tasks pane in the Team Planner view, click and drag tasks to any resource name. You can also drag to move existing task assignments to other resources.

3. **Click and drag a task to reschedule start and finish dates.** Simply click and drag a task to start earlier or later (drag left to start earlier, or drag right to start later).
Take Charge of Resources

The Team Planner view’s powerful interactive features make it easy to reschedule and reassign work. You can customize the look of Team Planner with color choices, filtering, grouping, and sizing. Moreover, you can balance resource demands with simple drag-and-drop assignment changes between resources to quickly fill in resource schedules and level tasks. Your entire project is updated at once and the new assignments are reflected in the Gantt chart and other Project 2010 views. No redundant effort required!

Resource Tab

The Resource tab on the Project 2010 Ribbon helps you plan and optimize resources with ease and precision. On the Resource tab you can quickly add resources to a schedule, assign resources to tasks, or level resources, all from one menu. You can also quickly move to the Team Planner view or other resource views while retaining access to the intuitive resource management features of the Ribbon.

Quick Tip

Add Resources from the Ribbon

You can find and activate relevant commands for planning and managing resources conveniently located on the Resource tab. For example, in the Insert group, you can add resources to your resource pool. Or, in the Assignments group, click Assign Resources to quickly and easily assign resources to tasks.

Flexible Choices for Resource Planning

Project 2010 continues to offer numerous resource types and options to help support project managers effectively plan resource requirements, including:

- **Work** resources for labor and other effort-based activities.
- **Material** resources for consumable items, such as concrete or lumber.
- **Cost** resources for financial expenditures associated with projects, such as travel or software.

- **Budget** resources for high-level work and cost estimates.
- **Generic** resources for demand analysis and resource planning.

You can assign custom attributes, such as location, skill, or cost type to resources to help you analyze demand and usage. In addition, you can designate resource assignments as **proposed** versus **committed** to support resource allocation analyses.
Take Charge of Resources

Simplified Resource Workload Analysis

Project 2010 offers many exciting features to help you pinpoint resource conflicts and balance demand.

Visual Cues Highlight Overloaded Resources

Project 2010 expands the types of visual cues that indicate resource over-allocation conditions. Using Project 2010, you can quickly target workload issues and take corrective actions to effectively align resources and manage expectations for your schedule. Examples include:

- A new red figure icon appears on task lines to indicate overloaded resources.
- Red lines and red font in the Team Planner view in Project Professional 2010 show over-allocated resources.
- Red histogram bars on resource graphs indicate over-allocated resources.
- Other Project 2010 resource views show over-allocated resources using bold red font.

Identify Workloads and Trends With Visual Reports

Using Visual Reports, introduced in Project 2007, you can take advantage of familiar Excel and Microsoft Visio® reporting capabilities to produce stunning visual charts and images. Project 2010 includes a number of Visual Reports specifically designed to provide insight into resource availability and workloads. Excel-based reports include intuitive charts that help you identify and analyze resource allocation. With time-phased reports, you can see workload and capacity trends. Using Excel pivot table reports, you can locate and analyze exceptional conditions to help proactively manage your workload forecast. Visio-based Visual Reports provide hierarchical summaries of resource capacity and availability. It is easy to save and distribute all Visual Reports to team members and stakeholders.

Enhanced Resource Leveling Helps Smooth Resource Workloads

Project 2010 enhances your choices for balancing workloads among individual resources. In earlier versions of the Project you could level resources across the entire project schedule. However, some situations, such as fixed deliverable dates, call for selective control over resource workload priorities to minimize effects on the overall project schedule.

In Project 2010, project managers can easily mitigate resource overload conditions by selectively leveling resources on a task-by-task basis. Using priority values on tasks with new leveling commands available on the Resource tab or in Task Inspector, you can easily reschedule lower-priority tasks to balance individual workloads. When used in conjunction with Team Planner, resource leveling provides an intuitive process to help find and resolve critical resource issues.

Figure 20 - Enhanced resource leveling
Manage Projects and Programs

Project 2010 provides insightful tools to help you get updates, find conflicts, test alternative scenarios, and see the effects of potential changes on your schedule and on your budget.

Monitor and Control Project Progress

Project managers need up-to-date information to gauge progress and to take corrective action if needed. Project 2010 offers in-program and connected solutions for keeping project plans current. Project Professional 2010 enhances team collaboration by giving project managers the tools to publish their schedules directly to SharePoint Foundation 2010. This two-way synchronization of task and assignment information can help small teams effectively collaborate and deliver projects on time and within budget.

Sharepoint Integration For Team Member Updates

With Project Professional 2010 your team can improve productivity by automating status updates. You can save your projects to a SharePoint Foundation 2010 (formerly Windows SharePoint Services) task list, and then map resource assignments on project tasks to SharePoint users on your team. Team members can choose to receive e-mail notifications of assignments, or see assignments when they visit the SharePoint Foundation 2010 task list. In addition, team members can directly update their progress and other task information in SharePoint Foundation 2010. You can synchronize team updates into the project schedule. See the section Collaborate and Connect for a full description of the collaboration opportunities that Project Professional 2010 and SharePoint Foundation 2010 offer you and your team.

Quickly Update Project Status

Project 2010 makes it easier for you to manage and control updates to your project plans. You can select your preferred method and level of precision for updating partial and completed activities. On the Task tab, you can quickly update the completion percentage of multiple tasks, update start and completion dates, and provide estimates for completing tasks. If additional details are needed, use time entry views to record actual hours performed by resources on tasks. To update your project and to set update options, on the Project tab, simply click Update Project.

Choose a Status Reporting Date

With Project 2010 you can choose the date—for example, the last day of the month—to report your schedule to team members and project stakeholders to use in variance analysis and performance reports. By selecting a status report date, you control the frequency and timing of project data used for status reporting.
Manage Projects and Programs

Perform What-If Analyses  IMPROVED!

Project managers often need to evaluate possible scenarios, and to consider options when planning new projects and monitoring ongoing work efforts. Project 2010 offers built-in tools to help support what-if analysis and scenario comparison.

- **Compare Projects.** The Compare Projects tool has been dramatically improved in Project 2010. With this tool you can compare two project plans and quickly and easily highlight the differences between them. Use Compare Projects for what-if analysis by first saving a copy of a project plan and then making your changes in the copy. Compare Projects lets you explore the differences between the original and proposed changes you have added to the file copy by using visual effects and information views to highlight the changes between the two files and their effects on your overall project schedule.

- **Multiple-Level Undo and Change Highlighting.** Using the Multiple-Level Undo feature, you can make multiple changes to your project plan to see the effects they will have on your overall project schedule, and then backtrack (or undo) your actions. Turn on Change Highlighting so you can easily identify changes as you make them, and quickly see the overall effect during what-if planning activities.

- **Inactive Tasks.** NEW!  PRO Using Inactive tasks in Project Professional 2010, you can create what-if scenarios within your project plan. You can make entire sections of a project inactive, and remove their effect on your project schedule, simply by designating the top-level summary task for that section Inactive. This approach makes it easy to compare and contrast one or more approaches in your schedule by simply toggling comparative sections between Active and Inactive mode.
QuickTip

Dynamically Change Start or End Date

You might be starting your plan from a template (or from an existing project plan), or perhaps you want to try different what-if scenarios by delaying your project or moving it forward in time. Whatever the case, you need to know how to reschedule your project—the Move Project command makes it easy. Project 2010 will automatically recalculate either the constraint or the deadline proportionate to how much the new project start date will shift.

Step by Step - Move Your Entire Project Back in Time or Out to the Future

1. **Define new project start date.** To adjust your project start date at any time, in the Gantt chart view, click the Project tab. In the Schedule group, click Move Project. In the New project start date box, type or click a new project start date, and then click OK. In the following example, the project start is being pushed out or delayed by one month.

2. **Move deadlines (or constraints).** This is a very handy option if your plan has any existing task constraints or deadlines associated with it. Project 2010 will automatically recalculate either the constraint or the deadline in proportion to how much the new project start date will shift. In this example, the milestone Implementation Complete had a deadline set for the middle of May. By delaying the start of the project by one month the new deadline will adjust to the middle of June. The same will apply to constraints such as Finish No Later Than set on the Implementation Complete task in this example. You can turn this option on or off by selecting or clearing the Move deadlines check box in the Move Project dialog box.
Create Compelling Reports for Insight and Analysis

The Visual Reports tool in Project 2010 offers an intuitive reporting solution that can provide historical perspectives and predictive insights into project results. Project 2010 offers resource assignment details to support new Visual Report analysis. Using several predefined reports, you can review and validate the conditions of your project. Examples of reports include Cash Flow Analysis, Critical Task Status, Resource Work Availability, and Earned Value Over Time. You can easily modify these reports or build your own templates to standardize reporting and gain perspective on your projects.

In addition to Project templates, in Visual Reports you can choose from report templates created in Excel and Visio. Project managers familiar with Excel can configure project data in Excel to gain perspective and analyze conditions that require action. Visio users can examine the details of graphical hierarchies to see work and resource breakdowns.

In addition to Visual Reports, Project 2010 continues to offer built-in reports that provide in-depth analysis of work details and cost conditions on your project. The Report Wizard helps you quickly and easily customize reports that can be printed and shared with project stakeholders.

Project Performance and Earned Value Management

Using Project 2010 you can easily monitor performance against your project plan. Flexible choices, including built-in earned value metrics, provide you with comprehensive performance management support for your projects.

Compare Actual Values to Baseline Estimates

Using Project 2010, you can set initial and interim project baselines to compare to current project statistics. Baseline figures capture your planned project timelines and costs. You can also design formula-based visual indicators to show status using your organization’s variance tolerances. For example, you can set an option to trigger an indicator in the Gantt chart view using traffic signal colors—red, yellow, and green—for schedule, cost, or work statistics that vary an indicated degree from your initial plan, or for items that are on time.

Create Earned Value Reports

Earned value reporting is built into Project 2010 views and reports. Project 2010 automatically calculates earned value performance indicators and offers visual reports to show earned value trends and predictive outcome reporting.
Get a Handle on Project Finances
Using Project 2010, you can easily manage finances by comparing top-down budgets with zero-based projected costs.

Establish Budgets
Project 2010 is the tool you need to create a budget for an entire project or program. Project 2007 introduced Budget Resources, the tool that project managers use to create high-level, time-phased cost estimates. You can assign user-defined cost categories, such as labor, travel, or capital procurement to Budget Resources for a finer level of budgetary control of your project in Project 2010.

Fill in Detailed Costs and Compare to Budget
Using Project 2010 you can easily build zero-based cost estimates for projects by assigning costs to individual resources and tasks. Costs are automatically rolled up for phase summaries and for the entire project. As bottom-up plans are elaborated, they can be compared to the high-level budgets you created using Budget Resources so you can confirm or modify estimates. When bottom-up plans are finalized, you can create baseline snapshots for comparison to top-down budgets and actual costs as progress is recorded in the project plan. Using Project 2010, you can more accurately monitor project financials and keep your project in sync with data in your accounting systems.

Effectively Monitor Programs with Master Projects
Project 2010 makes it easy to manage multiple projects in a single program. Using Master Projects, you can incorporate and consolidate multiple project files collectively in one file for comprehensive program management. This way, individual project managers can use a shared resource pool to collectively manage resources. In the Master Project file, project managers use the Team Planner tool to view and manage resource assignments across projects. You can create cross-project dependencies to help program managers in your organization control changes between project schedules.

64-Bit Options
Project Standard 2010 and Project Professional 2010 are offered in 32-bit and 64-bit options. Project 2010 64-bit option offers enhanced performance and handles extremely large project files with complex dependencies. Teams having robust program and resource management requirements can use Master Projects with Project Server 2010 for a comprehensive enterprise project management solution.
Collaborate and Connect

With Project Professional 2010, team members can easily collaborate and share project schedules and status using SharePoint® Foundation 2010. When connected to Project Server 2010, Project Professional 2010 is part of the Microsoft Enterprise Project Management solution helping organizations gain control across all types of work, improve project selection and strategic alignment, maximize resource utilization and visualize performance through powerful dashboards.

Connected Teams – SharePoint Synchronization

Connect your teams with Microsoft SharePoint Foundation synchronization. Using Project Professional 2010 you can synchronize project task status in SharePoint Foundation 2010 and Project Professional 2010 for bi-directional updates between you and individual team members. Project managers can choose when to synchronize updates from team members into their project plans. In addition, Project 2010 helps you resolve any conflicts in task information that are identified during synchronization.

Synchronizing team task status updates through SharePoint Foundation 2010 saves you money, time, and effort—some of your most valuable resources. It enhances communication between you and your team members, and makes that communication flexible and as frequent as you need it to be.

QuickTip

You can now team up members in SharePoint Foundation 2010

You can now team up members in SharePoint Server or SharePoint Foundation 2010 – it is now easier than ever. With the touch of a button, you can easily synchronize data via SharePoint Foundation 2010 for better collaboration with project stakeholders such as team members or senior management. Users can view information in a task list resembling a Gantt chart in SharePoint, and even provide updates with the click of a button. This synchronization is bi-directional, so project managers can both send and receive project schedule information with SharePoint while keeping all members of the project team informed of the latest updates.

Step by Step

1. Go To the Backstage View
   - Click the green File tab to open the Backstage view
   - Click the Share tab and browse to Sync with Tasks List

Continued on next page
2 Setup Sync with Task List
   - Click Sync with Tasks List
   - Confirm the Site URL displayed is correct and click Validate URL
   - Select an existing task list, or enter a new name of the task list for SharePoint
   - Click Sync

This automatically sets up a new task list in SharePoint using a simple Gantt chart format. You can view the task list in SharePoint and synchronize it anytime with the Project and team members updates, including revised dates or percentage completed.

3 Synchronize for Updates or Changes
When you make changes to your schedule in the Project or update the task list in SharePoint, you can synchronize anytime to keep the Project and Task List coordinated.
   - In the Backstage View, click on the Info tab
   - Click Sync on the Info tab options

**Enter the new name of the task list (or select an existing task list) that will appear in SharePoint.**
Add Fields for Synchronization

The Project chart provides synchronization for the Name, Start, Finish, % Complete, Resource Names, and Predecessor fields. You can also easily add additional built-in or custom fields for synchronization.

- In the Backstage view, click Info
- Under Sync to Tasks List area, click Manage Fields
- Click Add Field and select the fields you want to add from the Add Field box. Click OK twice.

Note: You need to have SharePoint Server 2010 or SharePoint Foundation 2010. It only works in the manual scheduled task mode (auto scheduled task will be changed to manual) and with links that are finish-to-start (FS) with no lags. Also, if you have resource assignments on tasks and would like to incorporate them in the SharePoint task list, they need to be setup as users with the exact same name in SharePoint.
Create Projects from SharePoint Lists

When team members collaborate, often informal lists—for example, lists of tasks captured in SharePoint Foundation 2010 (formerly called Windows SharePoint Services)—create the framework of a new project. Using Project Professional 2010, teams can connect and collaborate where and when they want, by using SharePoint Foundation 2010 and the project task list—a new list type in SharePoint Foundation 2010.

Incorporating SharePoint Foundation 2010 project task lists into Project Professional 2010 is simple and reduces data entry and redundant formatting. In the Project 2010 Backstage view, an easy-to-use wizard maps the fields in your SharePoint 2010 task list to Project 2010 fields. Standard fields, such as Due Date, are automatically mapped to standard Project fields; unique fields can be mapped to custom Project fields. Project 2010 retains the outline structure and summary task information of your SharePoint 2010 task list. Team members who are assigned tasks in a SharePoint list automatically become resources in your Project Professional 2010 schedule. Project 2010 will automatically create tasks in Manually Scheduled task mode when lists are copied or imported from another application.

Save Project Schedules to SharePoint

With Project 2010, you can use SharePoint Foundation 2010 to organize projects and collaborate on schedules with other team members. Team members can save project files directly to a SharePoint Foundation 2010 site using the Project 2010 Backstage view. Teams can take advantage of the rich content management, social computing, and file versioning features of SharePoint Foundation 2010 for enhanced collaboration on and control of their projects.

Connect to Project Server 2010

Project Server 2010 brings together the business collaboration platform of SharePoint Server 2010 with structured execution capabilities. That means you can better align resources and investments with business priorities, gain control across diverse work streams, and visualize performance with powerful dashboards.

Using Project Professional 2010, you and your organization can realize the results of unified project and portfolio management by adding Project Server 2010. Project Professional 2010 connects with Project Server 2010 so that project schedules can be centrally managed for enterprise visibility into program, project, and resource information.

With Project Professional 2010, you can connect to Project Server 2010 to create new enterprise-ready projects. Utilize the power of Project Professional 2010 to manage project plans connected to Project Server 2010 or make simple updates online using Microsoft Web App. Project Server 2010 empowers the mobile workforce by bringing the flexibility of Project Professional 2010 to the browser with Web-Based Project Scheduling.

Project Professional 2010 users can take advantage of the centralized resource pool database in Project Server 2010 to review resource availability when making assignment decisions. The Team Planner view empowers project managers to visually evaluate and manage resources right from their desktop. In addition, project managers save time when team members update their task status using the Web-based Timesheets tool in Project Server 2010.

Project Server 2010 is built on SharePoint 2010, giving Project Professional 2010 users access to all of the unique collaborative features of SharePoint 2010, and a wide array of dashboard reporting solutions available for enhanced enterprise project management.
Summary of Project 2010 Benefits

Microsoft® Project 2010 is a milestone release that delivers new and innovative features across the entire family of products. Project 2010, built on SharePoint 2010, offers flexibility and choice by providing tailored work management solutions for individuals, teams, and the enterprise. With Project 2010, you can effectively manage any type of work, from simple tasks to complex projects and entire programs.

Project Standard 2010 and Project Professional 2010 deliver powerful, visually enhanced ways to effectively manage a wide range of projects and programs. From meeting crucial deadlines, to selecting the right resources and empowering your teams, Project 2010 offers easier and more intuitive experiences to simply be productive and realize amazing results.

Increase productivity with the Ribbon, our Fluent™ user interface that unifies all Office 2010 applications, and that provides quick access to key features when you need them. Excel-like functionality provides familiar interactions so you can do more in less time and with less effort. Flexible scheduling capabilities allow occasional and professional project managers to experience greater control over their project timelines. Visual indicators and tools, such as the Task Inspector view, offer intuitive guidance for identifying issues and help users take action early.

The new Timeline view in Project 2010 helps you summarize and communicate key tasks and phases, and presents milestones with visual appeal and insight. With improved copy-and-paste capabilities, it is easier to share information with other Office applications while retaining formatting. Improved performance-tracking features and enhanced reporting help users manage projects with precision and control. Power users will appreciate the Project 2010 64-bit computing offerings, with enhanced performance and support for very large programs and projects.

Project Professional 2010 provides expanded functionality for project managers who want enhanced scheduling and resource planning capabilities, and who would like to take advantage of the collaborative benefits of SharePoint Foundation 2010 (formerly called Windows SharePoint Services). The new interactive Team Planner helps project managers visualize work requirements and optimize workloads with drag-and-drop efficiency. Two-way synchronization with SharePoint Foundation 2010, used in conjunction with Project Professional 2010, helps make teams more productive by automating updates between project managers and team members. Using Inactive tasks improves what-if planning and supports agile methodologies. When organizations are ready for an enterprise project management solution, Project Professional 2010 connects with Project Server 2010 to support unified project and portfolio management.
Summary of Project 2010 Benefits

What’s In Project Standard 2010 and Project Professional 2010 For You?

▪ Better experiences
  The Ribbon makes finding and using your favorite tools simpler with new graphical menus and a familiar experience so you can create and manage projects easily. In the new Microsoft Office Backstage view, you can save, share, print, and publish your projects with fewer clicks.

▪ Simply more productive
  Like other Microsoft Office applications, with Project 2010 you can save time and effort using familiar and essential functions like text wrapping, filtering, auto-complete, scroll, and zoom. Insert new columns on the fly—data types are readily identified so you can quickly organize and analyze details effectively.

▪ Flexible and powerful
  Bringing together the flexibility and ease of a tool like Microsoft Excel 2010 with the power of the Project Professional 2010 scheduling engine, user-controlled scheduling puts you in control.

▪ Easier to see and share
  With a completely new Timeline view, you will have a clearer view of tasks, milestones, and phases. Newly expanded color palettes and text effects help you make every project timeline and plan looks its best—to efficiently convey and share important dates and deliverables.

▪ At-a-glance resource management
  See the right mix of people and resources—simply drag-and-drop tasks and resources to effectively plan tasks for your entire team and project.

▪ Connected teams
  Connect your teams using Microsoft SharePoint Foundation 2010 synchronization or team up Microsoft Project Server 2010 with Project Professional 2010 to realize the results of unified project and portfolio management.
System Requirements and Compatibility

Project Standard 2010 and Project Professional 2010 have the following minimum system requirements:

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor:</strong></td>
<td>700 megahertz (MHz) or faster</td>
</tr>
<tr>
<td><strong>Memory:</strong></td>
<td>512 megabytes (MB) or more RAM</td>
</tr>
<tr>
<td><strong>Hard Disk:</strong></td>
<td>1.5 gigabytes (GB); a portion of this disk space will be freed after installation if you remove the original download package from the hard disk.</td>
</tr>
<tr>
<td><strong>Drive:</strong></td>
<td>Required drive number and types will depend on the application components and languages you install.</td>
</tr>
<tr>
<td><strong>Display:</strong></td>
<td>1024 × 768 or higher resolution monitor</td>
</tr>
<tr>
<td><strong>Operating System:</strong></td>
<td>Windows 7 or later operating systems, Windows Vista with Service Pack (SP) 1, Windows XP with SP3 (32-bit), Windows Server® 2008 with SP2 (32-bit or 64-bit), or Windows Server 2003 Release 2 (R2) with Microsoft XML Core Services (MSXML) 6.0</td>
</tr>
</tbody>
</table>
Versions and Compatibility

Version and Edition Comparison
To learn more about the new features in Project 2010 and for a detailed comparison of features between Project Standard 2010 and Project Professional 2010, go to:

- **Project Version Comparison**
- **Project Edition Comparison**

<table>
<thead>
<tr>
<th>Which version of Project is right for you?</th>
<th>Standard</th>
<th>Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simplified navigation.</strong> New graphical menus and a more intuitive experience make every action easier.</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td><strong>New timeline.</strong> With a clearer view of tasks, milestones, and phases—your timelines are easier to see and share.</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td><strong>Flexible scheduling.</strong> Reduce complexity with the ability to choose the level of detail that’s right for your project.</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td><strong>At-a-glance resource management.</strong> Visually create the right mix of resources—it’s as easy as drag and drop.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Easier collaboration.** Connect your teams with Microsoft SharePoint® Foundation 2010 synchronization or Microsoft Project Server 2010.

Compatibility with Earlier Versions
You can open files created in earlier versions of Project in Project Standard 2010 and Project Professional 2010. You can also save files in formats supported by earlier versions of Project; however, features that do not map to earlier versions, such as tasks scheduled using Manually Scheduled task mode, will be converted or abandoned when the file is saved in Project 2010.

You can save Project 2010 files in other formats, including XML, comma-separated value (CSV), text (tab-delimited), and Excel workbooks. You can also save Project 2010 files as Open Database Connectivity (ODBC) databases.
Additional Resources

For more information and to explore Project 2010 further, visit Microsoft Project.

To learn more about Project 2010, refer to the following list of related links:

- Official Project Blog
- Project Professional TechNet Forum
- Project Server TechNet Forum
- Microsoft Project Video Channel
- MSDN
- TechNet